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Chapter 1  
______________________________________ 

AK355 System  
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1.1 Introduction 

 
The AK355 Systems enable point-to-point Ethernet over Copper services and is 

ideally suited for demanding applications such as DSLAM Backhaul over long 

distances. The AK355C model offers point-to-point transport of DS3 or Ethernet 

over Copper, providing a smooth migration from TDM to IP at a later stage (the 

AK355CE model offers point-to-point transport of Ethernet only).  The systems 

bond together 2 to 16 copper pairs creating a symmetric or asymmetric high 

bandwidth link capable of delivering up to 100 Mbps out to 12 Kft/3.7 Km (24 

AWG) or 45 Mbps out to 17 Kft/5.2 Km (24 AWG).  

Positron’s signature FlexStream functionality enables the AK355 Systems to run 

either in symmetric or asymmetric mode with a simple software command. It 

allows service providers to dictate how much bandwidth is allocated to 

downstream vs. upstream traffic - an essential tool for ensuring precious 

bandwidth is used as efficiently as possible.   

The AK355 Systems consist of 1RU high Central Office and Remote units for 19” 

and 23” racks or for wall mounting. It is environmentally hardened and the 

Remote units can be either line or locally powered. 

 

Note:  Read Chapter 5 Safety and Warnings before proceeding.  
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1.2 Installation 

 

Mounting the AK355 

The AK355 units can be mounted in either 19 inch or 23 inch racks.  The 19 and 

23 inch flanges and mounting screws are included in the installation kit.  

Mounting holes are provided for flush or mid mount.  Note that the mid mount 

flange can be mounted forward or backward for either 5 or 6 inch recess.  Figure 

1 shows examples of 19 inch flanges attached to the flush position and 23 inch 

flanges attached to the mid mount position. 

 

 
Figure 1 Flange Wall Mounting 

The unit can also be mounted on a wall using either 19 or 23 inch flanges (see 

Figure 2)  It is not necessary for the flange to be bonded with the frame; the unit's 

Ground Lug on the back provides proper grounding. 
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Figure 2 Wall Mounting 

 

 

NOTE:  The fan filter should be replaced every six months.  Ordering information 

can be found at the end of this document.  
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1.3 AK355 Connections 

 

1.3.1 Front View  

Error! Reference source not found. shows the AK355 front panel.  The 

AK355C and AK355R units have identical front panel indicators and functions. 

1.3.1.1 Management Connections 

The RJ-45 port (located on the front panel) can be used for local or remote 

management access.  The Ethernet port automatically is set to either 10BaseT or 

100BaseT and auto-sense the polarity of TX/RX (automatic MDIX). 

Caution: In order to comply with the intra-building lightning surge requirements, 

intra-building Ethernet management wiring must be shielded, and the shield for 

the wiring must be grounded at both ends. 

 

Figure 3 AK355 Front View 
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AK355 Front Panel Indicators 

LED Condition Function 

Status 

Solid Green 
Flashing Green 
Solid Yellow 
Solid Red 

Normal 
DS3 Loopback Active (DS3 Only) 
Minor Alarm Active 
Critical or Major Alarm 

Fuse Off 
Red 

Unit Fuse OK 
Unit Fuse Has Blown 

Fan Alarm 
Solid Green 
Solid Yellow 
Flashing Red 

Fan Status Normal 
One Fan Has Failed 
More Than One Fan Has Failed 

MULTIPAIR 
SPAN 
STATUS 

Solid Green 
Solid Yellow 
Solid Red 

Normal 
Minor Alarm 
Critical or Major Alarm 

PAIR STATUS 

Off 
Solid Green 
Flashing Green 
Solid Red 

Pair Is Disabled 
Pair Is Up 
Pair Is Acquiring 
Pair LOS/Open Circuit/Short  

BAT A 
BAT B 

Off 
Solid Green 

External DC Power Has Not Been Applied 
External DC Power Is Present  

 

ACO Pushbutton  

Pushbutton Function 

ACO 

Push Alarm Cut Off pushbutton for at  
least 1/2 second, deactivates audio (not 
visual) relay for all active alarms.  The  
ALARM LED on the AK355 indicates 
ACO has been activated by the 
connection on the back of the unit.   
 
To temporarily override the AK355C IP 
Address, push and hold the ACO button 
until the Status LED turns off.  The 
management IP address of the CCU will 
revert to 192.168.10.1 for a period of 5 
minutes.  The AK355R will revert to the 
192.168.10.2 IP Address.   
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1.3.2 Rear View 

The rear views of the AK355 systems are similar less the DS3 connections on 

the AK355E model.    

1.3.2.1 Frame Ground Connections  

The Ground Lug located on the right hand side of the back panel (see Figure 4) 

can accommodate up to 6 AWG wire.  Use a wire gauge for grounding at least as 

heavy as the power wiring.  Attach the grounding wire to the AK355 Ground Lug 

to a nearby grounding screw on the equipment rack or facility ground.  Test the 

ground connection with an ohm meter; there should be less than 2 ohms 

between the AK355 Ground Lug and facility ground.   

 

Note that the ground connection is required for proper system operations.    

 
Figure 4 AK355 Rear View 
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1.3.2.2 Power Connections  

A 7.5A to 10A UL listed fuse/circuit breaker must be installed ahead of this unit. 

 

Two redundant power buses are provided (A and B).  The two power inputs are 

identical and can be used for redundant power configurations. 

Insert the ends of the -48 Vdc and Return power wires (16 AWG wire is 

recommended) into the A and B holes on the left side of the Phoenix plug.  Insert 

the Phoenix plug into the Power connector. 

 

Note:  The DC return terminal is not connected to the equipment frame or the 

grounding means of the equipment (Isolated DC Return). 

 

 
Figure 5 Power Connector 

 



AK355 System Installation and User's Guide 

 

 

Positron Access Solutions 13 180-0037-002 R02 

1.3.2.3 Multi-Pair Span Connection  

The MSPAN connector is used to connect the AK355 to the outside plant pairs. 

 

The Table shown below specifies the 50-pin AMP connector pin assignments. 

 

 

                                    Connector Pin Assignments 
 

Pair TIP RING 

Pair 1 26 1 

Pair 2 27 2 

Pair 3 28 3 

Pair 4 29 4 

Pair 5 30 5 

Pair 6 31 6 

Pair 7 32 7 

Pair 8 33 8 

Pair 9 34 9 

Pair 10 35 10 

Pair 11 36 11 

Pair 12 37 12 

Pair 13 38 13 

Pair 14 39 14 

Pair 15 40 15 

Pair 16 41 16 
 

 

The CO MSPAN cable should be shielded with a pigtail wire that attaches to the 

ground lug just above the MSPAN connector.  The RT MSPAN cable's shield 

should NOT be connected to ground (leave open).  The MSPAN cable is female.  

Tie wrap points are available in several places on the back panel.  The MSPAN 

cable can be routed to the left or right. 
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1.3.2.4 Alarm Connections 

Alarm connections are generally used on the CO end.  Insert alarm connections 

into the supplied Phoenix connector.  Alarm connections available are: 

 

 Critical, audio and visual 

 Major, audio and visual 

 Minor, audio and visual 

 SysID 

 Alarm-CutOff (ACO) 

 Aux1, Aux2 Alarm in  

 

Each alarm can be connected to Normally Open (NO) or Normally Closed (NC) 

position.  Use the Common (COM) connection to complete the connection.  

SysID connections can be used to identify the equipment in alarm.  SysID is 

active during any alarm activation.  Aux1 and Aux2 are input alarm dry contact 

relay point.  The Alarm-CutOff (ACO) connections are input dry contact relay 

points used for remote activation of ACO. 

 

Note: The AK355CPS and the AK355RP only support the Alarm In connections. 

 

1.3.2.5 -48 Vdc OUT Connection 

The AK355R and the AK355CPS can supply 48Vdc output to power external 

devices.  Note: DO NOT attach external voltages to these outputs.  

 

1.3.2.6 DS3 Connection 

Attach the transmit and receive DS3 coax cables to the In and Out BNC 

connectors on the back panel (see Figure 14). 

 

Note: See Chapter 8 for AK355 Systems that support DS3. 
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Chapter 2  
______________________________________ 

AktinoView Management Software  

Ethernet Mode 
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2.1 Introduction 

AktinoView is a Microsoft Windows software package used to manage one or 

more systems.  In AktinoView, the AK355 unit located at the Central Office is 

referred to as the CO and the AK355 unit located at the Remote Office is referred 

to as the RT. 

2.2 Installation 

To install AktinoView proceed through the following: 

 Insert the AktinoView CD into the CD ROM drive or download AktinoView 

from Positron's portal located at http://www.positronaccess.com 

 Open Windows Explorer and click on the CD drive 

 Double-click on install.exe in the AktinoView folder 

 Follow the instructions on the screen   

2.3 System Management 

2.3.1 Logging in to the System 

From the Start Menu select Aktino > AktinoView, and you will see a dialog box 

similar to the following: 

 

Enter a Username and Password appropriate for the system.  The default 

Username is "superuser" and the default password is "superuser".  Enter the 

system's IP address in the Equipment IP Address field, and Click Login.  The 

default IP address for the CO unit is 192.168.10.1 and the default IP address for 

the RT unit  is 192.168.10.2. 

http://www.positronaccess.com/
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2.3.2 Switching from DS3 Mode to Ethernet Mode (for Systems supporting DS3) 

1 Go to the Tools tab. 

2 Right click on the RT Unit.  Note: Always start this process by switching 

the RT unit first. 

3 Select Switch to Ethernet Mode from the RT drop-down box and then 

select OK.  This will initiate a process that will result with the RT rebooting.  

4 Right click on the CO once the RT disappears. 

5 Select Switch to Ethernet Mode from the CO drop-down box and then 

select OK.   This will initiate a process that will result with the CO 

rebooting.  Note: Wait a couple of minutes before continuing with the 

remainder of this process.  

6 Go to the File Menu and select Connect to...  This will bring up the Login 

to AktinoView dialog box. 

7 Type in the Username and Password.  The default Username is 

"superuser" and the default Password is also "superuser."    

8 Click Login. 

9 Follow the same process when returning to DS3 Mode. 
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2.3.3 AktinoView Main Window 

Once you are logged into the system you will see three menu options: 

 

File Menu 

The File Menu provides two options:   

Connect to: Allows you to connect to and manage several Aktino systems 

simultaneously.   

Exit: Exits the AktinoView program. 

Action Menu 

The Action Menu provides four options:  

 Refresh: Refreshes the system. 

System Backup:  Opens a dialog box allowing you to save your System 

Configuration in an XML file to your PC so that you may retrieve and 

restore the configuration at a later date.   

System Restore:  Opens a dialog box to import and apply a previously 

saved System Configuration file.  The process of restoring your system 

configuration will reboot your system.    

System Software Upgrade:  Opens a dialog box allowing you to upgrade 

the Aktino System software. (See Appendix A for System Software 

Upgrade procedures.)   

Export:  Provides three options: Alarm Log, Alarm History, and PM 

(Performance Monitoring).  These options allow you to export the desired 

information to a .csv file. 

Help Menu 

The Help Menu provides one option:   

About: Displays the AktinoView software version information. 

AktinoView provides Quick-Launch buttons    

for all the menus: 
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Under the Menus and Quick-Launch buttons, AktinoView displays a tab for all the 

systems currently being managed.  Each tab will display the System Name and 

IP address of the selected system. 

 

. 

When AktinoView connects to a given system, it will display several additional 

tabs appropriate for the selected system.  In this case, AktinoView displays the 

following tabs for the system in Ethernet mode: System, Inventory, Provisioning, 

Alarms, PM, Tools, Diagnostic, and License. 

AktinoView provides Alarm details by right-clicking on the unit.  If alarms are 

present in the system, AktinoView will display them at the bottom of the screen.  

For more information about a particular alarm, double-click on the alarm for 

details and trouble-shooting information.  
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Alarm Details 

AktinoView displays detailed alarm information for each system.  It displays 

counters for the active Critical, Major, and Minor alarms, as well as detailed 

alarm information for each of the alarms present.  The columns can be sorted 

and resized as desired. 
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2.3.4 System  

The System tab provides a front panel representation of the system. 

 

 
 

 

 



AK355 System Installation and User's Guide 

 

 

Positron Access Solutions 22 180-0037-002 R02 

2.3.5 Inventory  

The Inventory tab provides details for the CO and RT Units comprising the 

system.   
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It displays a Description for each of the devices, as well as their Serial Number, 

CLEI Code, Hardware and Software Revision Levels.  It also displays any 

applied feature options.   

 

       See the following table for Parameters and Values: 

Parameter Values 

Slot Slot number 

Unit Location 

Description Detailed description 

Serial Serial Number 

CLEI Code Telcordia assigned CLEI code 

MAC Address MAC Address for the device 

Hardware Rev. Hardware Revision Level 

Software Rev. Software Revision Level 

Options 

Asymmetric: Support for Asymmetric Mode 

2.2 Mhz: Support for 2.2 Mhz Mode 

Line Powering: Support for Line Powering Mode 
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2.3.6 Provisioning  

Clicking the Provisioning tab displays all the provisioning sub-sections supported 

by the system. 

 

2.3.6.1 Equipment  

Selecting the Equipment tab under Provisioning allows equipment provisioning of 

the system.   

 

Clicking on either a CO or RT unit brings up the Equipment dialog box for that 

specific unit.   
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See the following tables for Parameters and Values: 

AK355C Equipment 
Parameters 

Values 

System ID User configurable string of up to 20 characters 

Contact User configurable string of up to 64 characters 

Location User configurable string of up to 64 characters 

IP Address IP Address of the unit 

Subnet Mask Subnet Mask of the unit 

Gateway Address Gateway Address of the unit 

RT Proxy IP 
Proxy IP address of the CRU, used to access the CRU through the 
MSPAN link 

Allow CPE Management 
Access 

Enable or Disable local management access for CRU 

Regenerator Type For Regenerator Applications 

Other Span IP Address 
For Regenerator Applications, indicate the Other Span IP Address 
(Do not use the same IP Address as the device's management port) 

Span 2 Mgmt. IP Address 
For Regenerator Applications, indicate the Span 2 management IP 
address (Do not use the same IP Address as the device's 
management port) 

 

 

AK355R Equipment 
Parameters 

Values 

System ID User configurable string of up to 20 characters 

Contact User configurable string of up to 64 characters 

Location User configurable string of up to 64 characters 

IP Address IP Address of the unit 

Subnet Mask Subnet Mask of the unit 

Gateway Address Gateway Address of the unit 

Allow CPE Management 
Access Enable or Disable local management access for CRU 
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2.3.6.2 Ethernet  

Selecting the Ethernet tab under Provisioning allows Ethernet provisioning of the 

system.   
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Double-click on an Ethernet Port to bring up an Ethernet provisioning dialog box.  
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See the following table for the Parameters and Values: 

 

Ethernet Parameters Values 

Circuit ID User configurable string of up to 48 characters 

Speed Sets the Ethernet Speed for the selected port 

Duplex Sets the Ethernet Duplex for the selected port 

Priority Preference 

Sets the Priority Ranking for ingress Ethernet data to: 
VLAN, DiffServ, Port 
VLAN, Port 
DiffServ, Port 
Port Only 

Port Priority Sets the Port's Priority Ranking for the ingress Ethernet data 

Ingress Rate Limit 
(Mbps) 

Sets an ingress Rate Limit for the Ethernet data, where "0" means 
no Ingress Rate Limit is set 

VLAN Trust Mode 

For CRUs in Tunneled VLAN mode only (see Ethernet Services Tab): 
YES - RT Ingress packets which have a VLAN ID matching a 
provisioned VLAN ID will be passed through transparently, 
otherwise the packet is dropped. RT Egress packets are passed 
through transparently. 
 
NO - RT Ingress packets have the VLAN ID assigned to the port 
added to the packet (the outer VLAN ID if a VLAN ID is already 
present). RT Egress packets have the outer VLAN ID stripped. 

Untagged VLAN ID 
For CRUs in Tunneled VLAN mode only: 
The VLAN ID entered will be added to RT Ingress untagged packets, 
then checked for VLAN membership. 

Loopback Enabled 
Yes - Ethernet Loopback enabled 
No - Ethernet Loopback disabled 

State 
Up - Ethernet Port is in service 
Down - Ethernet Port is out of service 
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2.3.6.3 SNMP  

Selecting the SNMP tab allows setting SNMP receiver parameters.     

 

Double-clicking on the Index brings up the SNMP Trap Receivers dialog box 

enabling SNMP provisioning. 
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See the following for the Parameters and Values for both of these screens: 

 

SNMP Parameters Values 

System ID User configurable string of up to 20 characters 

Contact User configurable string of up to 64 characters 

Location User configurable string of up to 64 characters 

Read Community String The SNMP Read Community String for the AK355 System 

 

 

SNMP Trap Host Parameters Values 

IP Address IP Address of the SNMP Trap Receiver 

Community String SNMP Community String of the Trap Receiver 

Version SNMP Trap Version Number (v1 or v2) 
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2.3.6.4 MSPAN  

Selecting the MSPAN tab under Provisioning allows MSPAN provisioning of the 

system. 

Note: Configuring Line Powering on an AK355RP is done by connecting to the 

AktinoView session to the AK355RP instead of connecting to the AK355CPS.  
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Double-clicking on the Slot number entry in either the General Parameters area 

or the Advanced Parameters area provides the MSPAN Parameters dialog box 

for both General and Advanced Parameters. 
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See the following table for Parameters and Values: 

 

MSPAN General Parameters Values 

State 
Sets the MSPAN State: 
Up - MSPAN is in service 
Down - MSPAN is out of service 

Circuit ID User configurable string of up to 48 characters 

Mode 
Sets the MSPAN Mode: 
Symmetric  
Asymmetric  

MSPAN Rate (kbps) Sets the MSPAN Rate in Symmetric Mode 

Rate Upstream Sets the Upstream MSPAN Rate in Asymmetric Mode 

Rate Downstream Sets the Downstream MSPAN Rate in Asymmetric Mode 

Line Powering Sets Line Powering to:  Off, -135v, or -185v 

SNR Margin Sets the SNR Margin: 0 to 18dB 

Margin Threshold 
Sets the SNR Margin Threshold.  If the SNR Margin falls below 
this threshold, an Alarm will be generated 

Reserve Pairs Sets the number of Reserve Pairs 

PSD Mask 
Sets the PSD Mask: 
Auto - Selects the best PSD Mask automatically 
Select - M0, M1, M2, M3, M4 or M5 

2.2 Mhz 
If the 2.2 Mhz feature is enabled: 
Select - Auto, or No 
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Note:  PSD Masks attempt to equalize the upstream and downstream MSPAN 

rates and are optimized for particular loop lengths.   

PSD Mask Best for Loop Lengths (26 AWG) 

M1 0 to 6500 feet 

M2 6500 to  9500 feet 

M3 9500 to 11500 feet 

M4 11500 to 13500 feet 

M5 Greater than 13500 feet 

 

PSD Mask Best for Loop Lengths (24 AWG) 

M1 0 to 8667 feet 

M2 8667 to 12667 feet 

M3 12667 to 15333 feet 

M4 15333 to 18000 feet 

M5 Greater than 18000 feet 
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See the following table for Advanced Parameters and Values: 

 

MSPAN Advanced Parameters Values 

Reed-Solomon Upstream 
Calculated Reed-Solomon Overhead percentage Upstream: 
RS% = 2 * INP / Latency 

Reed-Solomon Downstream 
Calculated Reed-Solomon Overhead percentage Downstream: 
RS% = 2 * INP / Latency 

Latency Upstream Sets the Upstream Latency: 0, 1, 2, 4, 8, 12, 16, 20, 32msec 

Latency Downstream Sets the Downstream Latency: 0, 1, 2, 4, 8, 12, 16, 20, 32msec 

Impulse Protection Upstream 
Length of Upstream Impulse Noise Protection:  
50, 125, 250, 500, 750, 1000, 2000, 4000 µsec 

Impulse Protection Downstream 
Length of Downstream Impulse Noise Protection:  
50, 125, 250, 500, 750, 1000, 2000, 4000 µsec 

Power Back-Off Upstream Auto, -3 to 16dB 

Power Back-Off Downstream Auto, -3 to 16dB 

Rate Alarm Threshold MSPAN Rate Alarm Threshold for Symmetric Mode 

Rate Alarm Threshold Upstream MSPAN Upstream Rate Alarm Threshold for Asymmetric Mode 

Rate Alarm Threshold 
Downstream 

MSPAN Downstream Rate Alarm Threshold for Asymmetric 
Mode 
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2.3.6.5 Pair 

Selecting the Pair tab under the Provisioning tab allows Pair provisioning of the 

system.  
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Double-clicking on the Pair brings up the following Pair provisioning dialog box:   

 

 
 

 

See the following table for Pair Provisioning Parameters and Values: 

 
 

Pair Parameters Values 

Circuit ID User configurable string of up to 48 characters 

State 
Sets the Pair State: 
Up - Pair is in service 
Down - Pair is out of service 
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2.3.6.6 Ethernet Services 

2.3.6.6.1Type of Service 

Selecting the Ethernet Type of Services tab allows type of service provisioning of 

the system.  
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Double-clicking on a slot brings up the following Ethernet Service provisioning 

dialog box: 
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See the following table for Ethernet Type of Service Parameters and Values: 

 

Type of Service 
Parameters 

Values 

Service 

Transparent Switch - The CO and RT units behave as a 6-port switch (three 
ports on each end). Frames may go from any port to any other port. Frames 
are transported transparently. 
 
Transparent Port - CO/RT 1000BaseT Port-1 is connected to Port-1, Port-2 to 
Port-2, and Port-3 to Port-3 Data between each port is not mixed. SFP module 
cannot be used in this mode. 
 
Tunneled VLAN - VLAN IDs are assigned to each port. The VLAN IDs determine 
which packets go to which ports. 

Co QoS Mode 

QoS - Port, VLAN, and DiffServ priorities are used as the flow control 
mechanism. Pause frames are not sent for flow control 
 
Lossless - Pause frames are used as the flow control mechanism. The Port, 
VLAN, and DiffServ priorities are also active 

RT QoS Mode 

QoS - Port, VLAN, and DiffServ priorities are used as the flow control 
mechanism. Pause frames are not sent for flow control 
 
Lossless - Pause frames are used as the flow control mechanism. The Port, 
VLAN, and DiffServ priorities are also active 
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2.3.6.6.2 Quality of Service 

Selecting the Quality of Service tab unit allows Global Quality of Service 

provisioning of the system.  
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Double-clicking on any area in the VLAN Priority or IP Differential Service Priority 

brings up the following Ethernet Quality of Service provisioning dialog box: 
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See the following table for Quality of Service Parameters and Values: 

 

QoS Parameters Values 

Scheduling Type 
Weighted Fair Queuing 
Strict Priority 
Strict Priority & Weighted Fair Queuing 

MAC Address Aging 
Timeout 

Time in seconds after which MAC Addresses are removed from the 
MAC Address table 

Service Ether Type 
Value for Ether Type Field that is used when adding a service VLAN 
tag 

VLAN Priority 
Allows for the mapping of priority levels for each of the AK355 
System's eight priority queues 

IP Differential Service 
Priority 

Allows for the mapping of IP DiffServ ranges for each of the AK355 
System's eight system priority queues 
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2.3.6.6.3 VLAN 

Selecting the VLAN tab allows the VLAN provisioning of the system.  Note that 

this menu is available when the System is provisioned for Tunneled VLAN 

service. 
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Right-clicking on the Create VLAN button brings up the Create VLAN dialog box. 

 

 
 

 

 

 

See the following table for the VLAN Parameters and Values: 

 

VLAN Parameters Values 

VLAN ID Enter a VLAN ID from 1 to 4092. 

VLAN Name User configurable string of up to 31 characters. 

Uplink Port  
Specify the Uplink Port on the on AK355C Unit this VLAN ID 
is assigned to. 

RT Port(s) Specify the AK355R Port(s) this VLAN ID is assigned to. 
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2.3.6.6.4 VLAN Administration 

Selecting the VLAN Administration tab allows you to provision a management 

VLAN. The VLAN can be transparently passed through to RT ports to allow other 

equipment to use the same management VLAN. 
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Click VLAN Admin to bring up the following dialog box: 

 

 
 

 

See the following table for the VLAN Administration Parameters and Values: 

 

VLAN Administration 
Parameters 

Values 

VLAN ID 
Enter a VLAN ID from 1 to 4092, a value of 0 disables the 
Management VLAN 

IP Address The IP Address for the Management VLAN 

Subnet Mask The Subnet Mask for the Management VLAN 

Default Gateway The Default Gateway for the Management VLAN 

Uplink Port  
Specify the Uplink Port on the AK355C Unit this VLAN ID is 
assigned to 
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2.3.6.7 Craft Access  

Selecting the Craft Access tab under Provisioning allows management 

administration.  

 

 

 

 

 

 

 

 

 



AK355 System Installation and User's Guide 

 

 

Positron Access Solutions 51 180-0037-002 R02 

Click on Create to display the following Craft Access dialog box: 

 

 

The Craft Access dialog box provides fields where the Login Name and 

Password is created for the new Craft Access user. 
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2.3.6.8 IP Route 

The IP Route tab allows you to provision static routes for the CO unit. 

 

 

Click the Create button to display the following dialog: 
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IP Route Parameters Values 

Network Destination Destination Network Address 

Network Mask Network Mask 

Gateway Address Default Gateway Address 
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2.3.7 Alarms 

2.3.7.1 CO > Alarm Log 

The CO Alarm Log tab displays a list of all the alarms observed on the AK355C 

including time-stamp information as to when the alarm was triggered or cleared. 

Note: See Appendix B for more Alarm details. 
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2.3.7.2 CO  > Alarm History 

The CO Alarm History tab displays the alarms that have been observed by the 

CO unit and how many times each of the alarms has been observed, as well as 

the first and last times the alarm has been observed. 

Note: See Appendix B for more Alarm details. 
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2.3.7.3 RT  > Alarm Log 

The RT Alarm Log tab displays a list of all the alarms observed on the RT unit 

including time-stamp information as to when the alarm was triggered or cleared. 

Note: See Appendix B for more Alarm details. 
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2.3.7.4 RT  > Alarm History 

The RT Alarm History tab displays the alarms that have been observed by the 

RT unit and how many times each of the alarms has been observed, as well as 

the first and last times the alarm has been observed. 

Note: See Appendix B for more Alarm details. 
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2.3.8 Performance Monitoring (PM) 

The PM tab allows you to display detailed Performance related information for 

the system's Ethernet Ports, MSPAN interfaces, and individual MSPAN Pairs.  

This PM data is provided for both the CO and RT sides of the system. 

Note: See Appendix C for more details. 

 

2.3.8.1 CO > Ethernet > Summary 

The Summary tab displays Ethernet Link information and counters for the 

Ethernet Ports.  The page can be provisioned to refresh automatically, and time-

stamp information is displayed for each of the entries. 
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2.3.8.2 CO > Ethernet > Detail 

The Detail tab displays detailed Ethernet counters for the Ethernet Ports.  The 

page can be provisioned to refresh automatically, and time-stamp information is 

displayed for each of the entries. 
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2.3.8.3 CO > Ethernet > MAC Addresses 

The MAC Addresses tab displays the Ethernet MAC Addresses learned by the 

selected port.   

 

 

The page can be provisioned to refresh automatically, and scroll between the 

discovered MAC Addresses. 
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2.3.8.4 CO > MSPAN 

The MSPAN tab displays the upstream PM information for the MSPAN.  This PM 

data is separated into three sections: 

1 The heading section provides summary information for the MSPAN 

including upstream MSPAN Capacity, Rate, and SNR Margin values. 

2 The 15-Minutes section provides PM data for 15-Minute intervals for the 

last 24-hours. 

3 The 24-Hours section provides PM data for the previous 7 days. 

The page can be provisioned to refresh automatically, and time-stamp 

information is displayed for each of the entries. For more information see 

Appendix C. 
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2.3.8.5 CO > Pair > Summary 

The Summary tab displays the upstream Pair Summary information for all the 

Pairs supported by the MSPAN.  The page can be provisioned to refresh 

automatically, and time-stamp information is displayed for each of the entries.   
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2.3.8.6 CO > Pair > Current 15 Minutes 

The 15 Minutes tab displays the upstream Pair PM information for all the Pairs 

supported by the MSPAN for the last 15-minute interval.  The page can be 

provisioned to refresh automatically, and time-stamp is displayed for each of the 

entries.  For more information see Appendix C. 
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2.3.8.7 CO > Pair > Current 24 Hours 

The Current 24 Hours tab displays the upstream Pair PM information for all the 

Pairs supported by the MSPAN for the current day.  The page can be provisioned 

to refresh automatically, and time-stamp information is displayed for each of the 

entries. 
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2.3.8.8 CO > Pair > History 

The History tab displays the upstream PM information for the Pairs supported by 

the MSPAN.  This PM data is separated into three sections and the PM can be 

displayed for each of the Pairs of the MSPAN. 

1 The heading section provides summary information for the MSPAN 

including upstream Pair Capacity, Rate, and SNR Margin values. 

2 The 15-Minutes section provides PM data for 15-Minute intervals for the 

last 24-hours. 

3 The 24-Hours section provides PM data for the previous 7 days. 

The page can be provisioned to refresh automatically, and time-stamp 

information is displayed for each of the entries. 
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Note the highlighted portion of the Pair History screen shown below:  

 

 
 

Refresh: This button refreshes the screen counters based on the time interval 

selected from the drop down box to its right.   

Slot: This drop down selection is always "1" on the AK355.  

Pair: This drop down selects the Pair to be displayed in the PM counters.   
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2.3.8.9 RT > Ethernet > Summary 

The Summary tab displays Ethernet Link information and counters for the 

Ethernet Ports.  The page can be provisioned to refresh automatically, and time-

stamp information is displayed for each of the entries. 
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2.3.8.10 RT > Ethernet > Detail 

The Detail tab displays detailed Ethernet counters for the Ethernet Ports.  The 

page can be provisioned to refresh automatically, and time-stamp information is 

displayed for each of the entries. 
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2.3.8.11 RT > Ethernet > Circuit 

The Circuit tab shows performance monitoring traffic from the RT Port to the CO 

Port. 
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2.3.8.12 RT > Ethernet > MAC Addresses 

The MAC Addresses tab displays the Ethernet MAC Addresses learned by the 

selected port.   

 

 

The page can be provisioned to refresh automatically, and scroll between the 

discovered MAC Addresses. 
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2.3.8.13 RT > MSPAN 

The MSPAN tab displays the downstream PM information for the MSPAN.  This 

PM data is separated into three sections: 

1 The heading section provides summary information for the MSPAN 

including upstream MSPAN Capacity, Rate, and SNR Margin values. 

2 The 15-Minutes section provides PM data for 15-Minute intervals for the 

last 24-hours. 

3 The 24-Hours section provides PM data for the previous 7 days. 

The page can be provisioned to refresh automatically, and time-stamp 

information is displayed for each of the entries.  For more information see 

Appendix C. 
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2.3.8.14 RT > Pair > Summary 

The RT side, Pair Summary tab displays the downstream Pair Summary 

information for all the Pairs supported by the MSPAN.  The page can be 

provisioned to refresh automatically, and time-stamp information is displayed for 

each of the entries. 
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2.3.8.15 RT > Pair >Current 15 Minutes 

The Current 15 Minutes tab displays the downstream Pair PM information for all 

the Pairs supported by the MSPAN for the last 15-minute interval.  The page can 

be provisioned to refresh automatically, and time-stamp is displayed for each of 

the entries.  For more information see Appendix C. 
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2.3.8.16 RT > Pair > Current 24 Hours 

The Current 24 Hours tab displays the downstream Pair PM information for all 

the Pairs supported by the MSPAN for the current day.  The page can be 

provisioned to refresh automatically, and time-stamp information is displayed for 

each of the entries. 
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2.3.8.17 RT > Pair > History 

The History tab displays the downstream PM information for the Pairs supported 

by the MSPAN.  This PM data is separated into three sections and the PM can 

be displayed for each of the Pairs of the MSPAN. 

1 The heading section provides summary information for the MSPAN 

including upstream Pair Capacity, Rate, and SNR Margin values. 

2 The 15-Minutes section provides PM data for 15-Minute intervals for the 

last 24-hours. 

3 The 24-Hours section provides PM data for the previous 7 days. 

The page can be provisioned to refresh automatically, and time-stamp 

information is displayed for each of the entries. 
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Note the highlighted portion of the Pair History screen shown below: 

 

Refresh: This button refreshes the screen counters based on the time interval 

selected from the drop down box to its right.   

Slot: This drop down selection is always "1" on the AK355.  

Pair: This drop down selects the Pair to be displayed in the PM counters. 
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2.3.9 Tools 

The Tools tab displays two firmware partitions--the Active and Standby Firmware 

partition for each component of the system.  The Active partition contains the 

firmware version currently running.  The Standby partition is used for firmware 

upgrades and provides a means of having a backup firmware version on the 

system.     
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Right-Clicking on a CO unit allows you to select the following options:  

Option Description 

Software Upgrade - CO Only Upgrades the firmware in the CO Unit only. 

Revert Software and Reboot 
Reboots the CO unit, and when the unit reboots, the unit 

selects the firmware version in the Standby partition 

Reboot Reboots the CO unit 

Reset PM Resets only the Performance Monitoring data in the CO unit. 

Reset Logs Resets the Logs in the CO Unit 

Reset PM/Logs Resets the PM and Logs in the CO Unit 

Reset System to Factory Defaults Resets the unit to Factory Defaults 

Switch to Ethernet/DS3 Mode 
For systems supporting both modes, this option reboots the 

unit and configures it to come up in the other mode. 

Export Logs 
Opens a dialog box enabling you to export important system 

information for analysis by Positron Technical Support. 
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Right-Clicking on a RT unit allows you to select the following options: 

Option Description 

Revert Software and Reboot 

Reboots the RT unit, and when the unit reboots, the 

unit selects the firmware version in the Standby 

partition 

Reboot Reboots the RT unit 

Reset PM 
Resets only the Performance Monitoring data in the RT 

unit. 

Reset Logs Resets the Logs in the RT Unit 

Reset PM/Logs Resets the PM and Logs in the RT Unit 

Reset System to Factory 

Defaults 
Resets the unit to Factory Defaults 

Switch to Ethernet/DS3 

Mode 

For systems supporting both modes, this option 

reboots the unit and configures it to come up in the 

other mode. 
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2.3.10 Diagnostic 

Diagnostics can be run on the AK355 System.  There are two types of tests: 

Single Ended Loop Test (SELT) and Dual Ended Loop Test (DELT).  

    

2.3.10.1 SELT 

Single Ended Loop Test (SELT) provides diagnostics for each pair.  Follow this 

procedure to run SELT: 

1 SELT is service effecting.  The remote unit must be disconnected to run 

the test. 

2 The Pairs need to be calibrated.  To get distance from the chassis, 

remove the MSPAN connector from the chassis.  If removal of the MSPAN 

connector is not possible, calibration can be done at any point in the loop, 

including the MDF.  This point will be the start of the Line Length test. 

3 Click on the Calibrate button to start the calibration process.  The Status of 

the calibration is indicated. 

4 Connect the pairs back to the Outside Plant.  Ensure that the remote unit 

is NOT connected. 

5 Click on Start Testing button to run the SELT test.  The Status of the SELT 

test is indicated. 

6 The results can be exported to an Excel .csv file by clicking on the Export 

Test Result button. 
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The results of the SELT test are indicated below: 

 

For each pair, the following test results are available: 

 Line Length.  This is the physical line length, it is AWG agnostic.  If there 

are large differences in the line length of the pairs, it indicates possibly a 

short, open, ground fault, or bridge tap.  If the pair is open in the middle of 

a loop, the length will indicate where it exists. 

 Tip to Ground Resistance.  Ring to Ground Resistance.  Tip to Ring 

Resistance.  The results should show "Open" for all pairs since the remote 

is not connected.  If there is resistance on any pair, this indicates that 

there may be a problem. 
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2.3.10.2 DELT 

Dual Ended Loop Test (DELT) provides diagnostics for each pair.  Follow this 

procedure to run DELT: 

1 DELT is service effecting.  The remote unit must be connected to run the 

test. 

2 Click on Start Testing button to run the DELT test.  The Status of the 

DELT test is indicated. 

3 The results can be exported to an Excel csv file by clicking on the Export 

Test Result button. 

The results of the DELT test are indicated below: 

 

For each pair's tip and ring, the current in milliamps is indicated on itself and 

between that pair and every other pair being used in the AK355 System.  The 

screen shot above shows a normal result.  There should be current flowing 

between Pair1 and T1and R1, between Pair 2 and T2 and R2.  The current flow 

numbers should be close in value.  Large differences in the current flow values 

indicate a problem with that pair.  No current should be flowing between pairs.  If 

there is current flowing between pairs, this indicates a problem with those pairs, 

possible a short.  
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2.3.11 License 

The License tab displays the features that are activated for the AK355 System. 

 

 

Click on the CO unit to bring up the Software License dialog box.  Contact 

customer service to find out more about how to obtain licenses for the AK355 

system.  Note that the AK355 has only one license available.   
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See the following table for the Features and Values: 

 

Feature Values 

Asymmetric, 
2.2 Mhz,  
Line Powering 

Activated - This feature is activated on the selected slot 
Not Activated - This feature is not activated on the selected slot 
Not Supported- This features is not supported on the selected slot 
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Chapter 3  
______________________________________ 

AktinoView Management Software 

DS3 Mode  
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3.1 Introduction 

AktinoView is a Microsoft Windows software package used to manage one or 

more systems.  In AktinoView, the AK355 unit located at the Central Office is 

referred to as the CO and the AK355 unit located at the Remote Office is referred 

to as the RT. 

3.2 Installation 

To install AktinoView proceed through the following: 

 Insert the AktinoView CD into the CD ROM drive or download AktinoView 

from Positron's portal located at http://www.positronaccess.com 

 Open Windows Explorer and click on the CD drive 

 Double-click on install.exe in the AktinoView folder 

 Follow the instructions on the screen   

3.3 System Management 

3.3.1 Logging in to an AK355 System  

From the Start Menu select Aktino > AktinoView, and you will see a dialog box 

similar to the following: 

 

Enter a Username and Password appropriate for the AK355 System.  The default 

Username is "superuser" and the default Password is "superuser".  Enter the 

system's IP Address in the Equipment IP Address field and Click Login.  The 

default IP address for the AK355C is 192.168.10.1 and the default IP address for 

the AK355R is 192.168.10.2 

http://www.positronaccess.com/
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3.3.2  Switching from Ethernet Mode to DS3 Mode (for Systems supporting DS3) 

 

1 Go to the Tools tab. 

2 Right click on the RT Unit.  Note: Always start this process by switching 

the RT unit first. 

3 Select Switch to DS3 Mode from the RT drop-down box and then select 

OK.  This will initiate a process that will result with the RT rebooting.  

4 Right click on the CO Unit once the RT Unit disappears. 

5 Select Switch to DS3 Mode from the CO drop-down box and then select 

OK.   This will initiate a process that will result with the CO rebooting.  

Note: Wait a couple of minutes before continuing with the remainder of 

this process.  

6 Go to the File Menu and select Connect to...  This will bring up the Login 

to AktinoView dialog box. 

7 Type in the Username and Password.  The default Username is 

"superuser" and the default Password is also "superuser."    

8 Click Login. 

9 Follow the same process when returning to Ethernet Mode. 
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3.3.3 AktinoView Main Window 

Once you are logged into the system you will see three menu options: 

 

File Menu 

The File Menu provides two options:   

Connect to: Allows you to connect to and manage several Aktino systems 

simultaneously.   

Exit: Exits the AktinoView program. 

Action Menu 

The Action Menu provides four options:  

 Refresh: Refreshes the system. 

System Backup:  Opens a dialog box allowing you to save your System 

Configuration in an XML file to your PC so that you may retrieve and 

restore the configuration at a later date.   

System Restore:  Opens a dialog box to import and apply a previously 

saved System Configuration file.  The process of restoring your system 

configuration will reboot your system.    

System Software Upgrade:  Opens a dialog box allowing you to upgrade 

the Aktino System software. (See Appendix A for System Software 

Upgrade procedures.)   

Export:  Provides three options: Alarm Log, Alarm History, and PM 

(Performance Monitoring).  These options allow you to export the desired 

information to a .csv file. 

Help Menu 

The Help Menu provides one option:.   

About: Displays the AktinoView software version information. 

AktinoView provides Quick-Launch buttons    

for all the menus. 
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Under the Menus and Quick-Launch buttons, AktinoView displays a tab for all the 

systems currently being managed.  Each tab will display the System Name and 

IP address of the selected system. 

 

When AktinoView connects to a given system, it will display several additional 

tabs appropriate for the selected system.  In this case, AktinoView displays the 

following tabs for an AK355 System: System, Inventory, Provisioning, Alarms, 

PM, Tools, Diagnostic, and License. 

AktinoView provides Alarm details by right-clicking on the unit.  If alarms are 

present in the system, AktinoView will display them at the bottom of the screen.  

For more information about a particular alarm, double-click on the alarm for 

details and trouble-shooting information.
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Alarm Details 

AktinoView displays detailed alarm information for each system.  It displays 

counters for the active Critical, Major, and Minor alarms, as well as detailed 

alarm information for each of the alarms present.  The columns can be sorted 

and resized as desired. 
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3.3.4 System 

The System tab provides a front panel representation of the AK355 System. 
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3.3.5 Inventory 

The Inventory tab provides details for the AK355C and the AK355R comprising 

the AK355 System. 
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It displays a Description for each of the devices, as well as their Serial Number, 

CLEI Code, Hardware and Software Revision Levels.  It also displays any 

applied feature options.   

 

See the following table for Parameters and Values: 

Parameter Values 

Slot Slot number 

Unit Location 

Description Detailed description 

Serial Serial Number 

CLEI Code Telcordia assigned CLEI code 

MAC Address MAC Address for the device 

Hardware Rev. Hardware Revision Level 

Software Rev. Software Revision Level 

Options 

Asymmetric: Support for Asymmetric Mode 

2.2 Mhz: Support for 2.2 Mhz Mode 

Line Powering: Support for Line Powering Mode 
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3.3.6 Provisioning 

Clicking the Provisioning tab displays all the provisioning sub-sections supported 

by the AK355 System. 

 

3.3.6.1 Equipment 

Selecting the Equipment tab under Provisioning allows equipment provisioning of 

the system. 

 

Clicking on either a CO or RT unit brings up the Equipment dialog box for that 

specific unit. 
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See the following tables for Parameters and Values:  

AK355C Equipment 
Parameters 

Values 

System ID User configurable string of up to 20 characters 

Contact User configurable string of up to 64 characters 

Location User configurable string of up to 64 characters 

IP Address IP Address of the unit 

Subnet Mask Subnet Mask of the unit 

Gateway Address Gateway Address of the unit 

RT Proxy IP 
Proxy IP address of the CRU, used to access the CRU through the 
MSPAN link 

Allow CPE Management 
Access 

Enable or Disable local management access for CRU 

Regenerator Type For Regenerator Applications  

Other Span IP Address 
For Regenerator Applications, indicate the Other Span IP Address (Do 
not use the same IP Address as the device's management port) 

Span 2 Mgmt. IP Address 
For Regenerator Applications, indicate the Span 2 management IP 
address (Do not use the same IP Address as the device's management 
port) 

 

AK355R Equipment 
Parameters 

Values 

System ID User configurable string of up to 20 characters 

Contact User configurable string of up to 64 characters 

Location User configurable string of up to 64 characters 

IP Address IP Address of the unit 

Subnet Mask Subnet Mask of the unit 

Gateway Address Gateway Address of the unit 

Allow CPE Management 
Access Enable or Disable local management access for CRU 
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3.3.6.2 DS3 

Selecting the DS3 tab under CO unit allows DS3 provisioning of the system.   

 

 

Double-click on the CO or the RT to bring up the provisioning dialog box for the 

selected unit.  Note that some of the parameters changed on the CO are also 

reflected on the RT.  Double-click on the RT unit to provision the remainder of the 

RT's parameters and values.
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The following is the DS3 CO unit provisioning dialog box:  
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The following is the DS3 RT unit provisioning dialog box: 

 

 

 

See the following table for parameters and values: 
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  DS3 CO unit Parameters and Values table 

Parameters Values 

DS3 Circuit ID  Allows input of description 
of the DS3 circuit up to 48 characters.  

DS3 Line Format  
 

C-Bit Parity 
Asynchronous M13 

CO unit DS3 Line 
Build Out 

0..225 ft 
226..450 ft 

Output Mode (Alarm 
Mode)    

Normal - Idle, Alarm 
Indication Signal (AIS) 

Payload Type 
 

Channelized DS3 (TDM) 
ATM* 
Scrambled ATM* 
Clear Channel  

Loopback Timeout 
 

0, 20, 60, 3600 (24 hours) 
minutes  

FEAC Pass Through 
 

YES - DS3 FEAC loopback 
messages from the network 
are reacted upon by the CO. 
NO - DS3 FEAC loopback 
messages from the network 
are ignored. 

State 
UP - CO DS3 port is in service. 
Down - CO DS3 port is out of 
service. 

 

DS3 RT unit Parameters and Values table 

Parameters Values 

DS3 Circuit ID  
Allows input of description of the DS3 
circuit up to 48 characters.  

RT Unit DS3 Line Build 
Out 

0..225 ft 
226..450 ft 

State 
UP - RT DS3 port is in service 
Down - RT DS3 port is out of service 
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3.3.6.3 DS1 

Selecting the DS1 tab under the CO unit allows DS3 tributary provisioning of the 

system.      

 

 

Double-click on the Index to bring up the DS1 provisioning dialog box.  Note that 

this screen is only active if DS3 Payload Type is set to Channelized DS3 (TDM).  

The MSPAN rate is the sum rate of each DS1set to UP state.  
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The following is the DS1 provisioning dialog box:  

 

See the following table for parameters and values: 

 

                         DS1 Provisioning Parameters and Values 

Parameter Values 

Circuit ID 
Circuit ID of DS1 up to 48 
characters 

Priority 

0 [Low] through 7 [High] 
When system needs to 
downshift 
the MSPAN rate during 
adverse 
conditions (e.g. a pair failed), 
the 
priority parameter 
determines the 
order of DS1's dropped.   

State 

Down - DS1 tributary is not 
transported. 
UP - DS1 tributary is 
transported. 
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3.3.6.4 ATM Inband 

Selecting the ATM Inband tab under Provisioning allows ATM Inband 

Management provisioning of the system.  The DS3 Payload Type must be in an 

ATM mode to allow provisioning this item.   

 

 

Double-click on the line to bring up the following ATM Inband dialog box:  
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See the following table for parameters and values: 

 

                             ATM Inband Parameters and Values 

Parameters Values 

VPI Virtual Path Identifier 

VCI Virtual Circuit Identifier 

IP Address 
IP Address of the Positron unit (must  
be in a different subnet vs. the local 
 management port). 

Subnet Mask  Subnet Mask for the Positron Unit 

Default Gateway  Gateway address for the Positron Unit 
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3.3.6.5 AUX Alarms 

Selecting the AUX Alarms tab under Provisioning allows external alarm 

provisioning of the system.  These parameters determine how the AUX1 and 

AUX2 input pins on the Positron units react.  Note that the alarm input pins are 

Normally Open (NO).   
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Double-click on the Index to bring up the AUX Alarm provisioning dialog.  

 

 

See the following table for Parameters and Values: 

                              AUX Alarm Parameters and Values 

Parameters Values 

Alarm Type 
This value is reported as alarm 
type in the TL 1 alarm message 
up to 16 characters.  

Description 
This values is reported as alarm 
description in the TL1 alarm 
message up to 48 characters. 

Severity Critical, Major, Minor 

 



AK355 System Installation and User's Guide 

 

 

Positron Access Solutions 108 180-0037-002 R02 

3.3.6.6 SNMP 

Selecting the SNMP tab allows setting SNMP receiver parameters. 

 

 

Double-clicking on the Index brings up the SNMP Trap Receivers dialog box 

enabling SNMP provisioning. 
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See the following for the Parameters and Values for both of these screens: 

 

SNMP Parameters Values 

System ID User configurable string of up to 20 characters 

Contact User configurable string of up to 64 characters 

Location User configurable string of up to 64 characters 

Read Community String The SNMP Read Community String for the AK355 System 

 

 

 

SNMP Trap Host Parameters Values 

IP Address IP Address of the SNMP Trap Receiver 

Community String SNMP Community String of the Trap Receiver 

Version SNMP Trap Version Number (v1 or v2) 

 



AK355 System Installation and User's Guide 

 

 

Positron Access Solutions 110 180-0037-002 R02 

3.3.6.7 MSPAN 

Selecting the MSPAN tab under Provisioning allows MSPAN provisioning of the 

system. 

Note: Configuring Line Powering on an AK355RP is done by connecting to the 

AktinoView session to the AK355RP instead of connecting to the AK355CPS. 
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Double-clicking on a Slot entry in either the General Parameters area or the 

Advanced Parameters area provides the MSPAN Parameters dialog box for both 

General and Advanced Parameters. 
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See the following table for Parameters and Values: 

 

MSPAN General Parameters Values 

State 
Sets the MSPAN State: 
Up - MSPAN is in service 
Down - MSPAN is out of service 

Circuit ID User configurable string of up to 48 characters 

Mode 
Sets the MSPAN Mode: 
Symmetric  
Asymmetric  

MSPAN Rate (kbps) Sets the MSPAN Rate in Symmetric Mode 

Rate Upstream Sets the Upstream MSPAN Rate in Asymmetric Mode 

Rate Downstream Sets the Downstream MSPAN Rate in Asymmetric Mode 

Line Powering Sets Line Powering to:  Off, -135v, or -185v 

SNR Margin Sets the SNR Margin: 0 to 18dB 

Margin Threshold 
Sets the SNR Margin Threshold.  If the SNR Margin falls below this 
threshold, an Alarm will be generated 

Reserve Pairs Sets the number of Reserve Pairs 

PSD Mask 
Sets the PSD Mask: 
Auto - Select the best PSD Mask automatically 
Select - M0, M1, M2, M3, M4 or M5 

2.2 Mhz 
If the 2.2 Mhz feature is enabled: 
Select - Auto, or No 
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See the following table for Advanced Parameters and Values: 

 

MSPAN Advanced Parameters Values 

Reed-Solomon Upstream 
Calculated Reed-Solomon Overhead percentage Upstream: 
RS% = 2 * INP / Latency 

Reed-Solomon Downstream 
Calculated Reed-Solomon Overhead percentage Downstream: 
RS% = 2 * INP / Latency 

Latency Upstream Sets the Upstream Latency: 0, 1, 2, 4, 8, 12, 16, 20, 32msec 

Latency Downstream Sets the Downstream Latency: 0, 1, 2, 4, 8, 12, 16, 20, 32msec 

Impulse Protection Upstream Length of Upstream Impulse Noise Protection:  
50, 125, 250, 500, 750, 1000, 2000, 4000 µsec 

Impulse Protection Downstream Length of Downstream Impulse Noise Protection:  
50, 125, 250, 500, 750, 1000, 2000, 4000 µsec 

Power Back-Off Upstream Auto, -3 to 16dB 

Power Back-Off Downstream Auto, -3 to 16dB 

Rate Alarm Threshold MSPAN Rate Alarm Threshold for Symmetric Mode 

Rate Alarm Threshold Upstream MSPAN Upstream Rate Alarm Threshold for Asymmetric Mode 

Rate Alarm Threshold 
Downstream 

MSPAN Downstream Rate Alarm Threshold for Asymmetric 
Mode 

 

Note:  PSD Masks attempt to equalize the upstream and downstream MSPAN 

rates and are optimized for particular loop lengths.   

PSD Mask Best for Loop Lengths (26 AWG) 

M1 0 to 6500 feet 

M2 6500 to  9500 feet 

M3 9500 to 11500 feet 

M4 11500 to 13500 feet 

M5 Greater than 13500 feet 

 

PSD Mask Best for Loop Lengths (24 AWG) 

M1 0 to 8667 feet 

M2 8667 to 12667 feet 

M3 12667 to 15333 feet 

M4 15333 to 18000 feet 

M5 Greater than 18000 feet 
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3.3.6.8 Pair 

Selecting the Pair tab under the Provisioning tab allows Pair provisioning of the 

system. 
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Double-clicking on the Pair entry to bring up the Pair provisioning dialog box. 

 

 

 

 

See the following table for Pair Provisioning Parameters and Values: 

 

 

Pair Parameters Values 

Circuit ID User configurable string of up to 48 characters 

State 
Sets the Pair State: 
Up - Pair is in service 
Down - Pair is out of service 
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3.3.6.9 DS3 Loopback 

Selecting the DS3 Loopback tab under Provisioning allows you to enable DS3 

loopbacks on either the CO or RT unit.  Right click on the Unit to select the type 

of DS3 Loopback desired.  When a loopback is set, right clicking on the Unit will 

provide release loopback option.  
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The following screen shot from the System tab reveals a loopback set Toward 

Network. 
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3.3.6.10 Craft Access 

Selecting the Craft Access tab under Provisioning allows User Management 

Administration. 

 

 

Click on Create to bring up the following Craft Access dialog box: 
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The Craft Access dialog box provides fields where the Login Name and 

Password is created for the new Craft Access user. 
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3.3.6.11 IP Route 

The IP Route tab allows you to provision static routes for the AK355C. 

 

 

Click the Create button to display the following dialog box: 
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See the following table for the IP Route Parameters and Values: 

IP Route Parameters Values 

Network Destination Destination Network Address 

Network Mask Network Mask 

Gateway Address Default Gateway Address 
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3.3.7 Alarms 

 

3.3.7.1 CO > Alarm Log 

The CO Alarm Log tab displays a list of all the alarms observed on the AK355C 

including time-stamp information as to when the alarm was triggered or cleared. 

Note: See Appendix B for more Alarm details. 
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3.3.7.2 CO > Alarm History 

The CO Alarm History tab displays the alarms that have been observed by the 

AK355C and how many times each of the alarms has been observed, as well as 

the first and last times the alarm has been observed. 

Note: See Appendix B for more Alarm details. 

 

 



AK355 System Installation and User's Guide 

 

 

Positron Access Solutions 124 180-0037-002 R02 

3.3.7.3 RT > Alarm Log 

The RT Alarm Log tab displays a list of all the alarms observed on the AK355R 

including time-stamp information as to when the alarm was triggered or cleared. 

Note: See Appendix B for more Alarm details. 
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3.3.7.4 Alarm History  

The RT Alarm History tab displays the alarms that have been observed by the 

AK355R and how many times each of the alarms has been observed, as well as 

the first and last times the alarm has been observed. 

Note: See Appendix B for more Alarm details. 
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3.3.8 Performance Monitoring (PM) 

The PM tab allows you to display detailed Performance related information for 

the AK355 System's Ethernet Ports, MSPAN interfaces, and individual MSPAN 

Pairs.  This PM data is provided for both the CO and RT sides of the system. 

Note: See Appendix C for more details. 

 

3.3.8.1 CO > DS3  

DS3 performance monitoring shows the errors coming INTO the AK355C.  Ninety 

six fifteen minute time period bins and seven 24 hour time period bins display the 

DS3's performance monitoring.  Select Refresh to update screen.   
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See the following table for Performance Monitoring Parameters and Values: 

Parameters Values 

Ingress Cell Count 
Numbers of ATM cells flowing into 
either CO or RT Positron DS3 port 
(ATM modes only) 

Egress Cell Count 
Numbers of ATM cells flowing out of 
either CO or RT Positron DS3 port (ATM 
modes only). 

CVL Line Code Violations 

ESL Line Errored Seconds 

SESL Line Severely Errored Seconds 

LOSSL Line Loss of Signal Seconds 

CVP Path Code Violations 

CVCP Path Code Violations CP-bit Parity 

ESP Path Errored Seconds 

ESCP Path Errored Seconds CP-bit Parity 

SESP Path Severely Errored Seconds CP-bit Parity 

SESP Path Severely Errored Seconds 

SASP SEF/AIS Second C-bit Parity 

AISSP Path Alarm Indications Status Seconds 

UASP Path Unavailable Seconds 

EFS% Error Free Seconds % 
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3.3.8.2 CO > MSPAN 

The MSPAN tab displays the upstream PM information for the MSPAN.  This PM 

data is separated into three sections: 

1 The heading section provides summary information for the MSPAN 

including upstream MSPAN Capacity, Rate, and SNR Margin values. 

2 The 15-Minutes section provides PM data for 15-Minute intervals for the 

last 24-hours. 

3 The 24-Hours section provides PM data for the previous 7 days. 

The page can be provisioned to refresh automatically, and time-stamp 

information is displayed for each of the entries.  For more information see 

Appendix C. 
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3.3.8.3 CO > Pair > Summary 

The Summary tab displays the upstream Pair Summary information for all the 

Pairs supported by the MSPAN.  The page can be provisioned to refresh 

automatically, and time-stamp information is displayed for each of the entries. 
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3.3.8.4 CO > Pair > Current 15 Minutes 

The 15 Minutes tab displays the upstream Pair PM information for all the Pairs 

supported by the MSPAN for the last 15-minute interval.  The page can be 

provisioned to refresh automatically, and time-stamp is displayed for each of the 

entries.  For more information see Appendix C. 
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3.3.8.5 CO > Pair > Current 24 Hours 

The Current 24 Hours tab displays the upstream Pair PM information for all the 

Pairs supported by the MSPAN for the current day.  The page can be provisioned 

to refresh automatically, and time-stamp information is displayed for each of the 

entries. 
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3.3.8.6 CO > Pair > History 

The History tab displays the upstream PM information for the Pairs supported by 

the MSPAN.  This PM data is separated into three sections and the PM can be 

displayed for each of the Pairs of the MSPAN. 

1 The heading section provides summary information for the MSPAN 

including upstream Pair Capacity, Rate, and SNR Margin values. 

2 The 15-Minutes section provides PM data for 15-Minute intervals for the 

last 24-hours. 

3 The 24-Hours section provides PM data for the previous 7 days. 

The page can be provisioned to refresh automatically, and time-stamp 

information is displayed for each of the entries. 
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Note the highlighted portion of the Pair History screen shown below:  

 

 
 

Refresh: This button refreshes the screen counters based on the time interval 

selected from the drop down box to its right.   

Slot: This drop down selection is always "1" on the AK355.  

Pair: This drop down selects the Pair to be displayed in the PM counters. 
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3.3.8.7 RT > DS3 

DS3 performance monitoring shows the errors coming INTO the RT unit.  Ninety 

six fifteen minute time period bins and seven 24 hour time period bins display the 

DS3's performance monitoring.  Select Refresh to update screen.   
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3.3.8.8 RT > MSPAN 

The MSPAN tab displays the upstream PM information for the MSPAN.  This PM 

data is separated into three sections: 

1 The heading section provides summary information for the MSPAN 

including upstream MSPAN Capacity, Rate, and SNR Margin values. 

2 The 15-Minutes section provides PM data for 15-Minute intervals for the 

last 24-hours. 

3 The 24-Hours section provides PM data for the previous 7 days. 

The page can be provisioned to refresh automatically, and time-stamp 

information is displayed for each of the entries.  For more information see 

Appendix C. 
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3.3.8.9 RT > Pair > Summary 

The RT side, Pair Summary tab displays the upstream Pair Summary information 

for all the Pairs supported by the MSPAN.  The page can be provisioned to 

refresh automatically, and time-stamp information is displayed for each of the 

entries. 
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3.3.8.10 RT > Pair > Current 15 Minutes 

The Current 15 Minutes tab displays the upstream Pair PM information for all the 

Pairs supported by the MSPAN for the last 15-minute interval.  The page can be 

provisioned to refresh automatically, and time-stamp is displayed for each of the 

entries.  For more information see Appendix C. 
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3.3.8.11 RT > Pair > Current 24 Hours 

The Current 24 Hours tab displays the upstream Pair PM information for all the 

Pairs supported by the MSPAN for the current day.  The page can be provisioned 

to refresh automatically, and time-stamp information is displayed for each of the 

entries. 
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3.3.8.12 RT > Pair > History  

The History tab displays the upstream PM information for the Pairs supported by 

the MSPAN.  This PM data is separated into three sections and the PM can be 

displayed for each of the Pairs of the MSPAN. 

1 The heading section provides summary information for the MSPAN 

including upstream Pair Capacity, Rate, and SNR Margin values. 

2 The 15-Minutes section provides PM data for 15-Minute intervals for the 

last 24-hours. 

3 The 24-Hours section provides PM data for the previous 7 days. 

The page can be provisioned to refresh automatically, and time-stamp 

information is displayed for each of the entries. 
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Note the highlighted portion of the Pair History screen shown below:  

 

 
 

Refresh: This button refreshes the screen counters based on the time interval 

selected from the drop down box to its right.   

Slot: This drop down selection is always "1" on the AK355.  

Pair: This drop down selects the Pair to be displayed in the PM counters. 
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3.3.9 Tools 

The Tools tab displays the Active and Standby Firmware versions for each 

components of the AK355 System. 
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Right-Clicking on a CO unit allows you to select the following options:  

Option Description 

Software Upgrade - CO Only Upgrades the firmware in the CO Unit only. 

Revert Software and Reboot 
Reboots the CO unit, and when the unit reboots, the unit 

selects the firmware version in the Standby partition 

Reboot Reboots the CO unit 

Reset PM Resets only the Performance Monitoring data in the CO unit. 

Reset Logs Resets the Logs in the CO Unit 

Reset PM/Logs Resets the PM and Logs in the CO Unit 

Reset System to Factory Defaults Resets the unit to Factory Defaults 

Switch to Ethernet/DS3 Mode 
For systems supporting both modes, this option reboots the 

unit and configures it to come up in the other mode. 

Export Logs 
Opens a dialog box enabling you to export important system 

information for analysis by Positron Technical Support. 
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Right-Clicking on a RT unit allows you to select the following options: 

Option Description 

Revert Software and Reboot 

Reboots the RT unit, and when the unit reboots, the 

unit selects the firmware version in the Standby 

partition 

Reboot Reboots the RT unit 

Reset PM 
Resets only the Performance Monitoring data in the RT 

unit. 

Reset Logs Resets the Logs in the RT Unit 

Reset PM/Logs Resets the PM and Logs in the RT Unit 

Reset System to Factory 

Defaults 
Resets the unit to Factory Defaults 

Switch to Ethernet/DS3 

Mode 

For systems supporting both modes, this option 

reboots the unit and configures it to come up in the 

other mode. 
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3.3.10 Diagnostic 

Diagnostics can be run on the AK355 System.  There are two types of tests: 

Single Ended Loop Test (SELT) and Dual Ended Loop Test (DELT). 

3.3.10.1 SELT 

Single Ended Loop Test (SELT) provides diagnostics for each pair.  Follow this 

procedure to run SELT: 

1 SELT is service effecting.  The remote unit must be disconnected to run 

the test. 

2 The Pairs need to be calibrated.  To get distance from the chassis, 

remove the MSPAN connector from the chassis.  If removal of the MSPAN 

connector is not possible, calibration can be done at any point in the loop, 

including the MDF.  This point will be the start of the Line Length test. 

3 Click on the Calibrate button to start the calibration process.  The Status of 

the calibration is indicated. 

4 Connect the pairs back to the Outside Plant.  Ensure that the remote unit 

is NOT connected. 

5 Click on Start Testing button to run the SELT test.  The Status of the SELT 

test is indicated. 

The results can be exported to an Excel csv file by clicking on the Export Test 

Result button. 
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The results of the SELT test are indicated below: 

 

For each pair, the following test results are available: 

 Line Length.  This is the physical line length, it is AWG agnostic.  If there 

are large differences in the line length of the pairs, it indicates possibly a 

short, open, ground fault, or bridge tap.  If the pair is open in the middle of 

a loop, the length will indicate where it exists. 

 Tip to Ground Resistance.  Ring to Ground Resistance.  Tip to Ring 

Resistance.  The results should show "Open" for all pairs since the remote 

is not connected.  If there is resistance on any pair, this indicates that 

there may be a problem. 
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3.3.10.2 DELT 

Dual Ended Loop Test (DELT) provides diagnostics for each pair.  Follow this 

procedure to run DELT: 

1 DELT is service effecting.  The remote unit must be connected to run the 

test. 

2 Click on Start Testing button to run the DELT test.  The Status of the 

DELT test is indicated. 

3 The results can be exported to an Excel csv file by clicking on the Export 

Test Result button. 

The results of the DELT test are indicated below: 

 

For each pair's tip and ring, the current in milliamps is indicated on itself and 

between that pair and every other pair being used in the AK355 System.  The 

screen shot above shows a normal result.  There should be current flowing 

between Pair1 and T1and R1, between Pair 2 and T2 and R2.  The current flow 

numbers should be close in value.  Large differences in the current flow values 

indicate a problem with that pair.  No current should be flowing between pairs.  If 

there is current flowing between pairs, this indicates a problem with those pairs, 

possible a short.  
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3.3.11 License 

The License tab displays the features that are activated for the various units of 

the AK355 System. 

 

See the following table for the Features and Values pertaining to the screen 

above:   

 

Feature Values 

Asymmetric, 
2.2 Mhz,  
Line Powering 

Activated - This feature is activated on the selected slot 
Not Activated - This feature is not activated on the selected slot 
Not Supported- This features is not supported on the selected slot 
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Click on the CO unit to bring up the Software License dialog box. 

   

 

Contact customer service to find out more about how to obtain licenses. For the 

AK355, only the Line Powering license is available for purchase. 

 



AK355 System Installation and User's Guide 

 

 

Positron Access Solutions 149 180-0037-002 R02 

 

Chapter 4  
______________________________________ 

Technical and Regulatory Specifications 
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4.1 AK355 Technical Specifications 

 

System 

 Bandwidth over 16 pairs: 

 DS3 **: 45 Mbps Asymmetric or Symmetric at CSA Reaches with Full 

 Disturbers. 

 Ethernet: 100 Mbps Symmetric at 4 Kft 100 Mbps Asymmetric, 55 Mbps 

 Symmetric at CSA Reaches with Full Disturbers. 

 System Latency: 2 ms 

 Resiliency: Carrier Grade Automatic Pair Failure Protection  

 BER: 10-12 

 

Standard Interfaces: DS3** 

 Number of BNC Ports: 2 Per Card 

 Line Code/Rate: B3ZS/44.736 Mbps ± 20 ppm  

 Framing: C-bit Parity or M13 

 Payload Mode: Clear Channel, TDM, ATM, Scrambled ATM,  

 Timing: Internal or Line 

 

Standard Interfaces: Ethernet 

 Interfaces: Three 10/100BaseT RJ45 and one 100 BaseFX or 1000BaseX 

SFP port 

 Compliance:  IEEE 802.3 

 

Outside Plant Pairs 

 Technology:  MIMO on DMT 

 Number of pairs:  2 to 16 

 Connector: 50-pin Telco 

 Compliance: T1.417 (Spectral)  

 IEEE 802.3 

 

Management Interfaces 

 10/100T RJ45 

 

Front Panel Indicators 

 Status, Fuse, Fan Alarm, Battery A/B Alarm, SFP Status, Ethernet Link 

and Activity 

 Outside Plant Pair Status (16) 
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Layer 2 Features 

 VLAN Tagging:  IEEE 802.1q Support 

 Stacked VLAN Tagging 

 Priorities:  IEEE 802.1p, Port, or IP DSCP 

 Dynamic Bridging:  8K  MAC Addresses 

 Metro Ethernet Forum Certified (MEF9, MEF14)  

 

Electrical Specifications  

 AK355CP and AK355CP E units 

 -  Power Input: -42 to -56.7 Vdc 

 -  Max Heat Dissipation: 65 Watts 

 

 AK355R and AK355R E units  

 -   Line Powered by CO Unit or 

 -   Local Power Input: -42 to -56.7 Vds 

 -   Max Heat Dissipation:  60 Watts 

 -   Provides 48 Vdc, 15 Watt output 

 

 AK355CPS Unit 

 -  Line Powered by the AK355RP Unit 

 -  Local Power Input: -42 to -56.7 Vdc 

 -  Max Heat Dissipation:  60 Watts 

 -  48Vdc output  

 

 AK355RP Unit 

 -  Power Input: -42 to -56.7 Vdc 

 -  Max Heat Dissipation: 65 Watts 

 

Environmental Specifications 

 Operating Temperature:  - 40 to + 65º C 

 Storage Temperature:  - 40 to +70º C 

 Relative Humidity:  Up to 95%, Non-condensing 

 

Mechanical 

 Chassis Dimensions:  1.75” (45 mm) High (1RU) x 17.2” (437 mm) Wide x 

10.5” (267 mm) Deep 

 Weight:  Approximately 10 lbs (4.50 kg). 
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Alarm Contacts 

 Critical, Major, Minor, SysID 

  Alarm-Cutoff Pushbutton 

 Auxiliary alarm inputs (2) 

 

Network Management 

 TL1, SNMP  

 EMS or AktinoView    

 DS3 ATM Inband Management** 

 Ethernet VLAN Inband Management 

 

Regulatory Approval 

 NEBS  

 UL60950 

 FCC Part 15 Class A 

 

 

 
*24 AWG copper pair 

**AK355 System supporting DS3
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Maintenance 
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5.1 AK355 Fans and Filters 

The fans for the AK355 Systems should be replaced as needed.  Ordering 

information for fans can be found at the end of this document. 

The filters for the systems should be replaced every six months.  Care should be 

taken when replacing filters to ensure collected dust on the filters does not enter 

into the equipment.  Ordering information for filters can be found at the end of 

this document.   
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Safety and Warnings 
To ensure your safety when servicing and installing this equipment, please take 
the following precautions: 
 
A 7.5 to 10A UL listed use/circuit breaker must be installed ahead of this unit in 
the end use building installation. 
 
A fuse panel must be installed near the unit in accordance with the National 
Electrical Code so that it is accessible to the operator. 
 
A fuse panel must be provided as part of the building installation wiring in order 
to provide a UL required disconnect point. 
 
The Positron products accept -48Vdc for powering. The -48Vdc voltage range 
must be between -42.5Vdc to -56.5Vdc. 
 
Be careful when installing or modifying telephone lines; dangerous voltages can 
be present. It is unsafe to install telephone wiring during a lightning storm. 
 
Only qualified personnel should service this system. 
 
The equipment must be connected to a protective ground in accordance with the 
instructions provided in this manual. Improper grounding may result in an 
electrical shock. 
 
Follow local grounding practice to ensure a good frame ground connection to the 
Positron chassis. The frame ground is required for secondary voltage protection. 
 
For performance and safety reasons, only power supplies listed for use with 
telephone equipment by a locally recognized organization should be used with 
Positron equipment. 
 
All wiring external to the product should follow the local wiring codes. 
 
Use of this product in a manner other than defined in this installation guide may 
cause damage to equipment or injury to personnel. 
 
If a problem has been isolated to this unit, do not attempt to repair. The unit’s 
components are not user serviceable and therefore must not be replaced. Please 
return the unit to Positron for repair. 
 
All fuses on the unit are located in non accessible areas and are not field 
serviceable. Please return the unit to Positron for repair. 
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Observe local practice electrostatic discharge precautions when handling 
electronic equipment. Do not hold electronic plugs by their edge. Do not touch 
components or circuitry. Use a grounding wrist strap attached to grounding 
connection point on the left side of the chassis. Use only ESD-protective 
packaging materials when transporting equipment. 
 
Care should be taken when installing in a closed or multi-unit rack to ensure that 
the maximum operating ambient temperature of 65°C (149°F) is not exceeded. 
 
Installation of the equipment in a rack should be such that the amount of air flow 
required for safe operation of the equipment is not compromised. 
 
Connect the unit only to a properly rated supply circuit.  Reliable earthing 
(grounding) of rack-mounted equipment should be maintained. Particular 
attention should be given to supply connections other than direct connections to 
the branch circuit (e.g. use of power strips). 
 
 

 
 
 
During installation and service do not connect the chassis to a live power source. 
Ensure that fuses are removed from the fuse panel. 
 
This device complies with Part 15 of the FCC rules.  Operation is subject to the 
following two conditions:  AK355 & AK5000 Product Family 3 Document 180-
0037-001 R06A 
 
  1. This device may not cause harmful interference. 
  2. This device must accept any interference received, including  
       interference that may cause undesired operation. 
 
This product is intended for installation in Restricted Access Locations only. 
 
Mounting of equipment in a rack should be such that a hazardous condition is not 
achieved due to uneven mechanical loading. 
 
The Positron Multi Pair span interface is designed to coordinate with a standard 
300 Vdc gas discharge tube protector. Carbon block protectors shall not be used. 
The 300Vdc gas tube protector shall have the performance characteristics as 
follows: 
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  - DC Breakdown Voltage (Max.) 475 V @ 2000V/sec 
  - Impulse Breakdown Voltage (Max.) 650 V max @ 100 V/μsec 
 
NOTE: If line powering is enabled, voltage on MSPAN pairs is either -135Vdc or 
 -185Vdc. 
 
The effective capacitance of the units between the connection points for the 
conductors of the tip and ring is 46.2uF. The effective capacitance of the units 
between the connection point for one conductor of tip or ring and earth is 0.25uF. 
 
At the time of installation, a system assessment shall be carried out to ensure 
that the effective capacitance of the total system, including the capacitance of the 
equipment, does not exceed the values specified in Figure 2 of UL60950-21. 
 
At the time of installation, it shall be checked that the voltage rating of the wiring 
of the telecommunication network is adequate for the normal Positron unit’s 
circuit voltage, together with superimposed transients.  
 
 At the time of installation it shall be checked that all multi-pair span circuits to be 
connected together are all RFT-V circuits. In practical terms as all equipment 
supplied by Positron only uses RFT-V circuits, then it should be checked that the 
multi-pair span of Positron equipment is not connected to any other vendor’s 
equipment. 
 
 WARNING: The intra-building ports of the equipment are suitable for connection 
to intra-building or unexposed wiring or cabling only. The intra-building ports of 
the equipment MUST NOT be metallically connected to interfaces which connect 
to the OSP or its wiring. These interfaces are designed for use as intra-building 
interfaces only (Type 2 or Type 4 ports as described in GR-1089-CORE, Issue 4) 
and require isolation from the exposed OSP cabling. The addition of Primary 
Protectors is not sufficient protection in order to connect these interfaces 
metallically to OSP wiring. 
 
SUITABLE FOR MOUNTING ON CONCRETE OR OTHER NON-
COMBUSTIBLE SURFACE ONLY. 
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Positron will replace or repair this product within the warranty period if it does not 

meet its published specifications or fails while in service.  Warranty information 

can be found in your Positron customer web portal: 

http://portal.positronaccess.com/login.asp 

 

 

Positron Sales Pricing/Availability 

+1-949-258-0545 

 

Positron Technical Support 

Pre-Sales Applications/Post-Sales Technical Assistance:  

+1-949-258-0545 

7days/week, 24 hours/day 

 

Positron Repair 

Return for Repair/Upgrade: 

+1-949-258-0545 

http://ticketmaster.positronaccess.com/ 

 

Repair and Return Address 

Contact Customer Service prior to returning equipment to Positron. 

Positron Access Systems, Inc. 

4931 Birch Street 

Newport Beach CA 92660 

 

 

 

http://portal.positronaccess.com/login.asp
http://ticketmaster.positronaccess.com/
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Positron Products (AK355) 

 

Part Number Description 

AK355C 
AK355 CO Unit, DS3/Ethernet, 45Mbps DS3 or up to 100Mbps 
Ethernet at CSA, Local Powered 

AK355C P 
AK355 CO Unit DS3/Ethernet, 45Mbps DS3 and up to 100Mbps 
Ethernet at CSA, with Line Power Option 

AK355C E AK355 CO Unit, Ethernet Only up to 100Mbps at CSA, Local Powered 

AK355C PE 
AK355 CO Unit, Ethernet Only up to 100Mbps at CSA, with Line 
Power Option 

AK355CPS 
AK355 CO Unit, DS3/Ethernet, 45Mbps DS3 and up to 100Mbps 
Ethernet as CSA, Local Powered or Line Powered 

AK355CPS E 
AK355 CO Unit, Ethernet Only up to 100Mbps at CSA, Local Powered 
or Line Powered 

AK355R 
AK355 RT Unit, DS3/Ethernet, 45Mbps DS3 and up to 100Mbps 
Ethernet at CSA, Local Powered or Line Powered 

AK355RP 
AK355 RT Unit DS3/Ethernet Unit, 45Mbps DS3 and up to 100Mbps 
Ethernet at CSA, with Line Power Option 

AK355R E 
AK355 RT Unit, Ethernet Only up to 100Mbps at CSA, Local Powered 
or Line Powered 

AK355RP E 
AK355 RT Unit, Ethernet Only up to 100Mbps at CSA, with Line Power 
Option 

AK355RPT AIR AK355 Regenerator, DS3/Ethernet 

AK355RPTRC AIR AK355 Regenerator, DS3/Ethernet, Reverse Line Powered 

AK355RPT E AIR AK355 Regenerator, Ethernet Only 

AK355RPTRC E AIR AK355 Regenerator, Ethernet Only, Reverse Line Powered 

AK355TR AK355 Tracer Card 

AK355NTE00 AK355 Self Contained DS3/Ethernet Network Termination Unit 

AKCOPS AK355 CO Unit Power Supply, Universal Input, -48Vdc Output 320W 

AKRTPS AK355 RT Unit Power Supply, Universal Input, -48Vdc Output 130W 

AK300FAN Fan Asy, Spare AK300/355/555 

AK300FL6 AK355 Air Filter (6-Pack) 

AK300CON AK355 Connector Kit 
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Appendix A: 
______________________________________ 

System Software Upgrade 
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Proceed through the following steps to perform the System Software Upgrade: 

Note:  All MSPAN connections must be up.    

1 Go to http://www.positronaccess.com 

2 Select Partners > Partner Login.  

3 Select the Registered Users Click Here to Login option if you are 

already a registered user. 

 Note: If you are not a registered user, select the Partner Portal Request 

 Form option and allow 24-48 hours for your account to be setup.  

4 Enter  Name and Password into the FileMan Login dialog box located on 

the Customer/Partner Portal. 

5 Select Firmware - Unified General Release AK355.  

6 Select the appropriate software version. 

7 Select the corresponding self-extracting .exe file and store the file in the 

place of your choice on your PC. 

8 Extract the files from the self-extracting .exe file to a location of your 

choice. 

9 Go to the tool bar and select Action Menu >  System Software Upgrade... 

This will bring up the System Software Upgrade dialog box. 

10 Select the system you want to upgrade and then click on the Upgrade 

button. 

11 Select the folder with the firmware files created in step 8 and click the OK 

button. 

12 Select Yes to switch and reboot after upgrade if you choose to upgrade 

immediately.  Otherwise, you can switch and reboot manually later.  

13 Select OK to confirm the selected system(s) will be upgraded to the 

desired version. 

 The system will begin the process of upgrading the system.  Note that this 

 process will take a few minutes. The RT's will be the first to reboot 

 followed by the CO's.    

http://www.positronaccess.com/
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System Alarm Information 
 



AK355 System Installation and User's Guide 

 

 

Positron Access Solutions 167 180-0037-002 R02 

 

Alarm Entity Severity Alarm Description 

Loss of Signal PAIR MN The Circuit Pair signal is lost 

Short Circuit PAIR MN The Circuit Pair is shorted 

Open Circuit PAIR MN The Circuit Pair has been disconnected 

Ground Fault PAIR MN 
The Circuit Pair has been shorted to 
ground 

Loss of Signal MSPAN CR 
Loss of signal (LOS) is a condition where 
the received signal drops below threshold 
due to an obstruction 

Loss of Frame MSPAN CR 
LOF indicates that the CO Unit is 
attempting to sync up with the RT Unit 

SNR Margin Below 
Margin Threshold 

MSPAN MN 
The obtained SNR margin is below the 
configured SNR margin 

Line Powering Failure MSPAN CR 
Not enough cable pairs have been 
provisioned for the MSPAN or the overall 
cable distance is too long for Line Power 

Equipment Failure EQPT CR 
Generated when the system cannot 
communicate with line powering 
subsystem 

Mismatched Equipment EQPT CR 

Generated when software version on CO 
Unit is different than Software version on 
RT.  The data path will be down in this 
condition 

Mismatched Hardware EQPT CR 
CO Unit's Interface does not match the RT 
Unit's Interface (DS3/Ethernet mismatch) 

High Temperature COM MN 

Triggered when the temperature is 85 
degrees Celsius or above, once set the 
alarm is cleared after the temperature 
falls below 80 degrees Celsius 

Power A Failed COM MN No power detected on power input A 

Power B Failed COM MN No power detected on power input B 
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Alarm Entity Severity Alarm Description 

Environmental Alarm 1 COM MN Alarm detected from Alarm Connections 

Environmental Alarm 2 COM MN Alarm detected from Alarm Connections 

Fan Failure FAN MN|MJ 
Minor Alarm if one fan fails, Major Alarm 
if more than one fan fails 

Improper Fan Removal FAN MJ Fan Module cannot be detected 

Link Down ETHERNET NA No Ethernet equipment detected 

Loss of Signal DS3 CR 
No DS3 signal from the attached 
equipment 

Loss of Frame DS3 CR Loss of DS3 framing 

Rate Below Configured 
Rate Threshold 

MSPAN NA 

Capacity below configured rate.  Not 
enough cable pairs have been 
provisioned or the overall cable distance 
is too long for the desired data rate 

Alarm Indication Signal DS3 NA 
An alarm indication signal (AIS) is a valid 
framed signal with payload containing a 
repeating 1010 pattern is present 

Remote Alarm Indication DS3 NA Remote Alarm Indication detected 

Local Loopback DS3 NA Unit is in Local Loopback mode 

Line Loopback DS3 NA Unit is in Line Loopback mode 

Clock Change EQPT NA System time has been changed 

System Reboot COM NA System rebooted or was powered on 
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Appendix C: 
______________________________________ 

System MSPAN Error Information 
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MSPAN Errors Description 

CRC Error 

A CRC is a way of identifying if data was received error free. 
Transmitted data is divided into blocks that are appended with 1 or 2 
CRC bytes that are derived from the original data. The receiver re-
computes the CRC bytes from the received data and if there is a 
mismatch, it signifies that there was a mismatch between the 
transmitted and received data 

MSPAN ES 
An Errored Second is any second in which the MSPAN incurs a CRC 
error 

MSPAN SES 
A Severely Errored Second is and second in which the MSPAN 
exceeds 18 CRC errors or has suffered an LOF event  

MSPAN UAS 

An Unavailable second is any second in which the MSPAN is in LOS or 
LOF and has experienced 10 MSPAN SES's in a row (in which case 10 
SES shall be subtracted from the UAS total) 

Pair CS 
Any second during which a correctable error occurred, i.e. an error 
occurred during transmission, but the Reed Solomon (RS) error 
protection mechanisms was able to detect and correct it 

Pair ES An Errored Second is any second that has at least one CRC error 

Pair SES 
A Severely Errored Second is any second that has more than 18 CRC 
errors 

Pair UAS 
An Unavailable Second is any second with an LOS (Loss of Signal), 
LOF (Loss of Frame), or 10 SES in a row (in which case 10 shall be 
subtracted from the SES total) 

 


